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of the following scenarios:  

� Loading a model from the model repository and changing simple parameters like the applied load or the posture. For instance, the so-called StandingModel from the 
model repository allows for quick and easy addition of loads to certain predefined points on the model, and the system will compute the muscular reactions.  

� Modifying one of the existing motion capture models from the repository to your own lab setup by redefinition of the marker protocol, the force platforms and the 
lab coordinate system.  

� Modifying a model from the respository with some similarity to what you want. For instance, a normal bicycle model could be changed into a recumbent bike. In this 
type of modeling, the user is typically redefining the environment, i.e. non-human, part of the model.  

� Constructing a body model and its environment bottom-up. This can be necessary if you want to model an animal or make a detailed model of new type of joint. The 
basic steps of such bottom-up model construction are described in the tutorial Getting Started with AnyScript , which is a good place tutorial to complete after this 
one, even if you do not plan to build models bottom-up.  

These various levels of model building complexity are covered in The Building Block Tutorial in the Making Things Move tutorial.  

As you can see above, the more detailed approaches are covered by other tutorials. To get you up and running quickly, we shall take the top-down approach in this tutorial 
and use the model repository to accomplish the following:  

1. Load the predefined standing model, place it in a given posture, and apply an external force to it.  
2. Modify the predefined standing model to carry a hand bag.  
3. Create a new model and import a predefined collection of body parts from the library to obtain a model of a simple gymnastics exercise.  

This entire tutorial relies heavily on the body model repository. It is a library of predefined models and body parts developed by scientists as a research undertaking and 
maintained by AnyBody Technology. A version of the repository compatible with your software version comes with the installation of AnyBody, but you can always find 
the newest version of the repository online at the AnyScript Community , which is a free service where e verybody is welcome to contribute. The site is managed jointly 
by the   AnyBody Research Group   and   AnyBody Technology A/S   with the latter sponsoring the expenses. The direct link to the models is 
http://forge.anyscript.org/gf/ .  

Before you continue you must unpack the entire repository and save it on your hard disk. A selection of models from the repository are included in the demo collection 
which is installed with AnyBody. These demo models should be sufficient for your work with this and other tutorials, but because the repository in continuously updated it 
may be a good idea to download and unpack the newest version of the AnyBody Managed Model Repository before you start any serious modeling work.  

The demo models, including the Standing Model to be used in this tutorial, are available from the Demo tab of the AnyBody Assistant dialog box.  

  

Scroll down a little and find this link:  

  

Click the link and browse to a location where you want to keep and work on your models, for instance “My Documents\AnyScripts\”. This procedure ensures that it is easy 
to reinstall the demo models later, which may be useful when you have been playing around with them for a while; this way you can reset all the changes you have made or 
reinstall them to a new location, if you wish to keep your own changes.  

With the repository unpacked, let’s take a brief look at its structure. Please open a file manager and navigate to the place you unpacked the repository. You should be able 
to discover the following folder structure:  

  

Applications are the models that can be loaded into AnyBody and actually simulate some biomechanical situation, such as cycling, lifting a box or propelling a wheelchair. 
Body contains models of body parts and collections of body parts which are used by the applications. For instance, Body includes a lumbar spine model, which is used by 
all the applications needing an upper body.  
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A closer inspection of the Application branch reveals that it has three sub folders:  

  

The Beta folder contains models that are unfinished but may be of value to users with special interests. The Examples folder contains many models of different situations 
and it is very likely that you will be able to find a model similar to what you want to do in it. The Validation folder contains models that have been used for validation 
purposes, typically by comparison of the model predictions with experimental measurements.  

With that knowledge, you are all set to go, and you can proceed with Lesson 1: Using the standing model .  

   

Lesson 1: Using the standing model  

As mentioned in the introduction, the model repository contains many applications in the Examples folder. A few of these are generic in nature and can serve dual 
purposes: Either they can be used as they are or with minor modifications or they can be modified and become models of something else. The Standing Model is one of 
these general applications, and we shall use it here by virtue of its first ability, i.e. pretty much as it is.  

The standing model can be found in the repository under Applications/Examples. The model comprises most of the available body parts in the library. The main file is 
called StandingModel.Main.any, and this is the one you must load.  

You can open the file with the File->Open menu in AnyBody or by Windows Explorer, but can also you access the more popular demo files through the Demo tab of the 
AnyBody Assistant dialog box. After installing the demo models as described in the introduction, the Demo tab will contain links to the more popular example models, 
including the Standing Model.  

The standing model has a few predefined features and some that you can modify. Here is a short list:  

� The model is supported by having both its feet connected to ground. The feet can move with the posture, but they are always supported by the connection with the 
floor.  

� The posture of the model is controlled via anatomical angles for all major joints except the ankles. The model has a place where these joint angles can be specified 
directly. We shall return to this topic shortly.  

� The model automatically balances its posture by means of the ankle angles such that its collective center of mass remains vertically above the ankle joints. For 
instance, if the model extends the arms in front of it, then the ankles will adjust and move the entire model slightly backwards to maintain the balance.  

� The model has a set of predefined points to which can be applied three-dimensional external forces simply defined as spatial vectors. When doing so, the muscles of 
the model will be recruited to balance the external forces. However, the ankle angles do not adjust in response to the external forces, so it is possible to apply an 
external force large enough to require tension between the feet and the floor. Because of the grounding condition of the feet such a tension will be provided by the 
model but the situation may not be realistic because real feet rarely stick to the ground.  

It is time to load the model. You do this by pressing the Load Model button    in the editor window toolbar or the load model button in the mainframe toolbar:  

  

Reload is a frequent operation for AnyBody users, so the same function has been assigned to function key F7.  

After loading is completed, the menu selections Window -> Model View (new) should produce the following result:   
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The icons in the toolbar at the top of the Model View window allow you to modify the image, zoom, pan, rotate, etc. They should be mostly self explanatory. Now is a 
good time to play a bit around with them and familiarize yourself with the options.  

By now you have probably noticed that you can pan, zoom and rotate the model by selecting the appropriate button on the toolbar. In practical use of the system it is often 
necessary to change quickly between these functions, so keyboard shortcuts have been provided:  

� The Ctrl button activates the Pan function.  
� The Shift button activates the Zoom function.  
� The Ctrl-Shift combination activates the rotation function.  
� If you have a scrolling wheel on your mouse, this will zoom the model in and out.  

Depending on the speed of your computer and especially the speed of your graphics card you may experience some delay when you change rotate and pan the model. This 
is due to the high level of detail of the model and this delay also applies to other operations you may want to perform. Therefore, it is advantageous to switch off the 
muscles as long as we are trying to get the model to do what we want. When it is working correctly we can just switch the muscles back on.  

Please go to the editor window and scroll down a little until you get to this place:  

// Select the body model: 

    // ---------------------- 

    // This file contains a list of all body parts, select them to create 

    // the body model wanted. 

    #include  "BodyPartsSetup.any" 

 

Please double-click the include line. It opens up the BodyPartsSetup file in which you can select which body parts to include and their muscle options. The file contains 
segments for each body part, for instance:  

// RightArm: 1 included, 0 not included 

// ************************************ 

#define RIGHT_ARM 1 

//This is the basic model, following additions available 

#define RIGHT_DETAILLED_HAND 0 

#define RIGHT_SHOULDER_RHYTHM 0 

// This is just the bones, 

// Choose one of the following options to add muscles 

#define RIGHT_ARM_SIMPLE_MUSCLE 1 

#define RIGHT_ARM_SIMPLE_MUSCLE_ONLY_ON_NECK 0 

#define RIGHT_ARM_MUS_3E 0 

 

In these definitions, a ‘0’ at the end of a line means that the option is not selected, while a ‘1’ means that it is selected. In the block above, the right arm is included in the 
model in a version with a simple hand and no shoulder rhythm, and it is equipped with simple muscles. If you make the following change (marked with red)…  

// RightArm: 1 included, 0 not included 

// ************************************ 

#define RIGHT_ARM 1 

//This is the basic model, following additions available 

#define RIGHT_DETAILLED_HAND 0 

#define RIGHT_SHOULDER_RHYTHM 0 

// This is just the bones, 

// Choose one of the following options to add muscles 

#define RIGHT_ARM_SIMPLE_MUSCLE $0$ 

#define RIGHT_ARM_SIMPLE_MUSCLE_ONLY_ON_NECK 0 

#define RIGHT_ARM_MUS_3E 0 

 

…then muscles will be excluded from the right arm. The StandingModel shares this method of setting up the body model with many of the other examples in the 
repository.  

Please go ahead and set the SIMPLE_MUSCLE option to zero for all the body parts. Then press F7 to reload the model. This time, the reload should be much faster than 
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the first time, and the model view window should update to showing the skeleton without muscles.  

This enables us to proceed to  Lesson 2: Controlling the posture .  

   

Lesson 2: Controlling the posture  

The Standing Model has been set up to have its posture defined by specification of anatomical angles in the joints. These specifications have been collected in one of the 
model files, mannequin.any. You can see where this file is included if you scroll down a bit in the StandingModel.any file until you come to this point:  

// The Mannequin file specifies load-time positions for all the segments 

// in the HumanModel. This is important for the model's ablity to resolve 

// all the kinematic constraints when the model is analyzed. 

// The mannequin file also drives those degrees of freedom of the human  

// model that are not governed by problem-specific drivers at run time.         

#include "Mannequin.any" 

If you double-click the Mannequin.any file name in the editor window, then the file opens up a new window. The first part of the file contains some logic to handle the fact 
that different models have different body parts. Please skip over that and scroll down until you see the following structure (In the interest of legibility we have removed 
many of the lines):  

AnyFolder Mannequin = { 

   

  AnyFolder Posture = { 

     

    AnyFolder Right = {       

    }; 

     

    AnyFolder Left = { 

    }; 

  }; 

   

AnyFolder PostureVel={   

     

    AnyFolder Right = {       

    }; 

     

    AnyFolder Left = { 

    }; 

  }; 

   AnyFolder Load = { 

     

    AnyFolder Right = { 

    }; 

    AnyFolder Left = { 

    }; 

  };  // Loads 

   

}; 

This file is typical for the AnyScript language in the sense that it is organized into so-called folders, which is a hierarchy formed by the braces. Each pair of braces delimits 
an independent part of the model with its own variables and other definitions.  

Everything in this file is contained in the Mannequin folder. It contains specifications of joint angles, movements, and externally applied loads on the body. Each of these 
specifications is again subdivided into parts for the right and left hand sides of the body respectively.  

The first folder, Posture, contains joint angle specifications. You can set any of the joint angles to a reasonable value (in degrees), and when you reload the model it will 
change its posture accordingly. Please make sure that the values are as follows:  

AnyFolder Right = { 

      //Arm  

      AnyVar SternoClavicularProtraction=-23;   //This value is not used for initial position 

      AnyVar SternoClavicularElevation=11.5;    //This value is not used for initial position 

      AnyVar SternoClavicularAxialRotation=-20; //This value is not used for initial position 

       

      AnyVar GlenohumeralFlexion = 0;  

      AnyVar GlenohumeralAbduction = 10;  

      AnyVar GlenohumeralExternalRotation = 0;  

       

      AnyVar ElbowFlexion = 0.01;  

      AnyVar ElbowPronation = 10.0; 

       

      AnyVar WristFlexion =0; 

      AnyVar WristAbduction =0; 

       

      AnyVar HipFlexion = 0.0;  

      AnyVar HipAbduction = 5.0;  

      AnyVar HipExternalRotation = 0.0; 

       

      AnyVar KneeFlexion = 0.0;  

       

      AnyVar AnklePlantarFlexion =0.0;  

      AnyVar AnkleEversion =0.0;  

    }; 

When these parameters are set for the right hand side, the left hand side automatically follows along and creates a symmetric posture. This happens because each of the 
corresponding settings in the Left folder just refers back to the setting in the right folder. The ability to do this is an important part of the AnyScript language: Anywhere a 
number is expected, you can write a reference to a variable instead, or even a mathematical expression, if you need it.  

If at any time you want a non-symmetric posture, simply replace some of the variable references in the Left folder by numbers of your choice.  
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Further down in the Mannequin.any file you find the folder PostureVel. This is organized exactly like Posture, but the numbers you specify here are joint angle velocities in 
degrees per second. For now, please leave all the values in this folder to zero.  

Finally, the last section of the file is named Load. At this place you can apply three-dimensional load vectors to any of the listed points. These load vectors are in global 
coordinates, which means that x is forward, y is vertical, and z is lateral to the right. Let us apply a vertical load to the right hand as if the model was carrying a bag:  

AnyFolder Load = { 

    AnyVec3 TopVertebra = {0.000, 0.000, 0.000}; 

     

    AnyFolder Right = { 

      AnyVec3 Shoulder  = {0.000, 0.000, 0.000}; 

      AnyVec3 Elbow     = {0.000, 0.000, 0.000}; 

      AnyVec3 Hand      = {0.000, -50.000, 0.000}; 

      AnyVec3 Hip       = {0.000, 0.000, 0.000}; 

      AnyVec3 Knee      = {0.000, 0.000, 0.000}; 

      AnyVec3 Ankle     = {0.000, 0.000, 0.000}; 

    }; 

    AnyFolder Left = { 

      AnyVec3 Shoulder  = {0.000, 0.000, 0.000}; 

      AnyVec3 Elbow     = {0.000, 0.000, 0.000}; 

      AnyVec3 Hand      = {0.000, 0.000, 0.000}; 

      AnyVec3 Hip       = {0.000, 0.000, 0.000}; 

      AnyVec3 Knee      = {0.000, 0.000, 0.000}; 

      AnyVec3 Ankle      = {0.000, 0.000, 0.000}; 

    }; 

  };  // Loads 

The downward load of -50 N in the right hand roughly corresponds to a weight of 5 kg or 10 lbs. Please reload the model (by pressing F7). If you have done everything 
right, you should see the comforting message 'Loaded Successfully' in the message window at the lower left hand side of the AnyBody main frame window. Now it is time 
to perform an analysis.  

On the left hand side of the screen you find a tall, narrow window with tabs on its left edge. Please select the Operations tab and find the following:  

  

What you see are different operations, i.e. analysis types, the system can perform on the model. Select the InverseDynamics and click the Run button on the toolbar:  

  

You will see the model move slightly into position and and you are finally awarded with the following message:  

...Inverse dynamic analysis completed 
Total simulation time: 1.593  

The standing model has been set up in such a way that when the muscles are removed from the model, they are automatically replaces by joint torque providers with 
strengths roughly equivalent to the normal strength of the different degrees of freedom of our joints. So what the analysis has done in the absence of muscles is to compute 
the necessary joint torques to balance gravity and the hand load in the posture we have selected.  

You have just completed your first analysis of an AnyBody model. In the next lesson we shall briefly examine the results and also see what happens if we ad muscles to the 
model: Lesson 3: Reviewing analysis results .  

Lesson 3: Reviewing analysis results  

AnyBody contains a number of facilities to investigate results of the analysis. One of them is the ChartFX window, which is a standard graphing tool for display of analysis 
results. Please click Window -> ChartFX 2D (new). A new window containing a blank field in the middle and a tree view in the left hand pane appears.  

The tree expands to reveal the entire structure of output data generated by AnyBody. Every element in the model generates some form of output from the analysis, so the 
tree is very large. One of the first nodes you encounter is the MaxMucleActivity variable:  
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Clicking the node produces an empty cordinate system in the large field. The reason why it is empty is that the standard setting of the ChartFX View is to display time-
varying data for moving models. In this simple case our model is static, so it does not make much sense to draw curves. Instead we shall switch the setting to Bar diagrams 
in by the Gallery button in the toolbar:  

  

You will obtain the following Image:  

  

This tells you that to stand upright and carry the 50 N load in the right hand, the model is using about 13% of its strength. This means that the highest relative load of any 
joint in the system is 13.1% the joint’s strength. Even though one number is a very simplified way of regarding a complex biomechanical system, there are good 
mathematical reasons why this particular number is a good measure of the human effort of a particular task.  

You can obtain more detailed information if you expand the Model branch in the tree view on the left hand side of the bar diagram. Going down through Model -> 
HumanModel -> Right -> ShoulderArm -> JointMuscles gives you a list of all the joints in the right shoulder and arm, and inside each joint you can find its corresponding 
joint “muscle”. We write “muscle” in quotation marks because it is of course not a real muscle but rather an approximation of the total strength in this joint. Try opening 
the FEJnt branch, and you will see it split into an ElbowFlexion and an ElbowPronation part. Proceed to open the ElbowFlexion branch and you get two folders with the 
same name except for the capitalization of the letters. The interesting one is the lower case jnt0 folder. Please open it up and see the folder named “Muscle” inside, which 
again splits into PosMuscle and NegMuscle. This requires a bit of explanation:  

The elbow obviously can do flexion and extension and different anatomical muscles are involved in these movements. This means that the strength in flextion would 
normally be different from the strength in extension, and to capture this difference, the joint needs joint torque providers with different strengths for the two directions of 
motion. Since the degree-of-freedom is called ElbowFlexion, it is assumed that flexion is the positive direction and extension is negative, and hence the names of the two 
“muscles” associated with this joint.  

Please open up PosMuscle and click Fm. This will give you the following bar:  

Page 7 of 229AnyBody™ Tutorials

8/29/2011file://C:\Users\Matthew\AppData\Local\Temp\~hhAD5A.htm



  

Fm is the muscle force property, which in the case of a joint torque provider is a moment, so the bar indicates that the elbow flexion moment it between 5 and 6 Nm. The 
tree contains leaves for all of the joint torque providers in both directions for all degrees-of-freedom of the model, and you can plot bar diagrams just like we did for the 
elbow flexion.  

But it might be more interesting to work with anatomical muscles. To do this, we need to re-insert the muscles into the model. Please open the BodyPartSetup.any file 
again and change ‘0’ back to ‘1’ in all of the “SIMPLE_MUSCLES” lines. Then press F7 again to reload the model. This time you have to wait a bit longer for the load 
process because the many muscles take time to process. When loaded, the Model View should automatically change to display the model including the muscles:  

  

Make sure that InverseDynamics is still selected in the operations tree, and click the Run button again. The model will jump into position as it did before and the muscles 
will initially stand out from the model but after a few moments fall back into place. The analysis takes more time than before but eventually should finish the “Inverse 
dynamic analysis completed” message.  

If you study the Model View carefully, you may be able to notice a slight change of color of some of the muscles, for instance the biceps of the right arm. This coloring is 
the system’s way of showing the relative load, i.e. the activation level, of each muscle. For models with larger loads, the coloring is more pronounced. Another method of 
immediate graphical feedback from the model is muscle bulging. This and other graphical settings can be controlled from a file called DrawSettings.any. You will find it 
included at the top of most of the example models in the repository. If you open this file (just double-click the line where it is listed in the editor) then you see different 
sections pertaining to the display of different parts of the model. Please make the following changes:  

AnyFolder Muscle ={  

    AnyVec3 RGB = .Colors.AnyBodyRed; 

    AnySwitch Visible =On; 

    AnySwitch DrawScaleOnOff =Off; 

    AnyVar Bulging = $1$; 

    AnyVar ColorScale =1.0; 

    AnyVec3 RGBColorScale = {0.957031, 0.785156, 0.785156}; 

    AnyVar MaxStress = $100000$; //N/m^2 //This number is for graphics only! 

    AnyVar Opacity =1.0; 

  }; 

These changes switch the muscle bulging on and also set a bulging factor (MaxStress) that results in visible bulging with the relatively small loads we have applied to this 
model. The resulting Model View should look like this:  
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Let’s take a look at the actual muscle forces. Please go back to the ChartFX view and browse down its tree to 
Main.Study.Output.Model.HumanModel.Right.ShoulderArm.Mus. You will see all of the anatomical muscles in the right arm displayed. A bit down this list you can find 
the muscle supraspinatus, which tends to be one of the sources of rotator cuff pain. Like many of the muscles in the model, the anatomical muscle supraspinatus is divided 
into several mechanical branches to account for fibers going in different directions and attaching to different bones. If you open op Supraspinatus_3 you can find the 
property Fm inside. Click it once, and you should see a new bar illustrating the force in this muscle element similar to the picture below.  

  

This shows that the force in this muscle branch is roughly 10 N. Notice the specification line above the graphics pane marked with the red circle above. This is where the 
specification of the current picture is listed. You can use this to plot several muscles at the same time. If you change  

Main.Study.Output.Model.HumanModel.Right.ShoulderArm.Mus.supraspinatus_3.Fm  

to  

Main.Study.Output.Model.HumanModel.Right.ShoulderArm.Mus.supraspinatus_*.Fm  

i.e. replace the figure 3 with an asterix, '*', then you should see a bar diagram of all the supraspinatus muscles in the right hand side of the body.  
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The use of asterix for specification of multiple muscle forces can be extended even further. If you change the specification line to…  

Main.Study.Output.Model.HumanModel.Right.ShoulderArm.Mus.*.Fm  

…then you will get a bar diagram of all the muscles in the right shoulder and arm:  

  

The different muscles do indeed have very different forces. You can see the muscle name in a little pop-up window if you hold the mouse still over a given bar.  

Congratulations! You have just completed your first biomechanical analysis with the AnyBody Modeling System. Now is a good time to play a bit around with the 
facilities of the system and the model. Try changing the posture and/or the load in the mannequin.any file and investigate the results again.  

You may also want to check our library of previous webcast for topics of particular interest to you.  

   

Getting started with AnyScript  

AnyScript is the model definition language of the AnyBody body modeling system.  

AnyScript is actually an object-oriented programming language developed specifically for describing the construction and behavior of bodies of living creatures. It can also 
model the different environment components that the body happens to be connected to. Typical examples would be bicycles, furniture, sports equipment, hand tools, and 
workplaces.  

AnyScript contains facilities for definition of bones (called segments), their connections by joints, muscles, movements, constraints, and exterior forces.  

One of the ideas behind AnyScript is that its text-based format and object-oriented structure makes it easy to transfer elements between models. You can build a library of 
body segments for use in your different analysis projects, and you can easily exchange models with other users and collaborate with them on complex modeling tasks.  

The syntax of AnyScript is much like a Java, JavaScript, or C++ computer program. If you already know one of these programming languages, you will quickly feel at 
home with AnyScript. But don't be alarmed if you have no programming experience. AnyScript is very logically constructed, and this tutorial is designed to help new users 
getting started as gently as possible.  
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So let us take the bull by the horns and get you introduced to the world of body modeling with AnyScript. This tutorial comprises six lessons during which you will 
complete your first AnyScript model, a simplified model of an arm.  

Each lesson (after lesson 1) begins with a link to a file with the AnyScript code. If you have a problem making your own code work, simply download the file and start 
from there.  

This tutorial consists of the following lessons:  

� Lesson 1: Basic concepts  
� Lesson 2: Defining segments and displaying the model  
� Lesson 3: Connecting segments by joints  
� Lesson 4: Definition of movement  
� Lesson 5: Definition of muscles and external forces  
� Lesson 6: Adding real bone geometries  

Let's get started with Lesson 1: Basic concepts  

   

Lesson 1: Basic concepts  

The AnyBody system contains an editor designed for authoring AnyScript files. So the first thing to do is to get AnyBody up and running. Double-click the AnyBody icon, 
and you should be greeted by the AnyBody Assistant and behind that an empty workspace.  

  

As you can see, the Main Frame window contains a smaller frame at the bottom. This frame provides much of your interaction with the system once you have a model 
running. Notice now in particular the empty rectangular lower portion of the frame. It is the Output Window. The system talks to you through this window. Notice that this 
window as well as many other text views in AnyBody can contain active links like in a HTML browser. These links can help you navigate faster around in the system.  

As computer software goes, AnyBody is much like any other Computer-Aided Engineering tool. You can create data from scratch, you can read in previously defined data, 
and you can exchange data between models. Once you have your data in place, you can perform various actions on it. Let us begin by creating a new AnyScript model. The 
menu clicks File -> New Main will bring up a new window in which you can construct your model using the AnyScript language.  

  

The new window is basically a text editor. This main pane of the Editor window will contain the actual AnyScript text. The system has already created the skeleton of a 
model for you from a built-in template.  

The narrow pane attached to the left side of the Main Frame is a tree view pane, where you find hierarchical representations of the model defined in the text window. If you 
are familiar with modern feature-based CAD systems, this idea will be very familar to you. Almost the same tree views are available on the Editor windows containing the 
AnyScript code, but they are closed by default. These additional tree views give you the possibility to browse large models in several views at a time. The following tree 
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